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Performance Objectives

Upon successful completion of Chapter 6, you will be able to:
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Create a report using the Report button

Modify the record source

Select, edit, size, move, and delste controf objects
Sort records

Find data

Display and customize a report in Print Preview
Delete a repont

Format a report

Apply conditicnal formatting to data in a report
Group and sort records in a report

Insert a calculation in a report

Greate a report using the Report Wizard

Create maifing fabels using the Label Wizard

Check your
current skills to
help focus your
shudy.

In this chapter, you will learn how to prepare yeports from data in a table or query
using the Report button in the Reports group on the Create tab and using the
Report Wizard, You will also learn how to manage control objects, format, and
insert a calculation in a report and create mailing labels using the Label Wizard.

Before beginning chapter work, copy the AL1C6 folder to
| your storage medium and then make AL1C8 the active foider.

oy
SNAY
1f you are a SNAP
user, launch the
Precheck and
Tuterials from your
Asslgnments page.
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Creating a Report

Create a Report

1. Click table or query
in Navigation pane.

2. Click Create tab.

3. Click Report button. -

Report

‘¢ Hint Create a
report to control what
data appears on the
page when printed.

Creating a Report

Create a report in a database to control what data appears on the page when
printed and how the data is formatted. Reports generally answer specific questions
(queries}. For example, a report could answer the question What customers have
submitted claims? ox What products do we currently have on order? The record source
for a report can be a table or query. Create a report with the Report button in the
Reports group or use the Report Wizard that provides steps for creating a report.

Creating a Report with the Report Button

To create a report with the Report button, click a table or query in the
Navigation pane, click the Create tab, and then click the Report button in the
Reports group. This displays the report in columnar style in Layout view with
the Report Layout Tools Design tab active, as shown in Figure 6.1. Access
creates the report using all of the fields in the table or query.

Figure 6.1 Report Created with Sales Table
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( Modifying the Record Source

The record source for a report is the table or query used to create the report. If

( changes are made to the record source, such as adding or deleting records, those
changes are reflected in the report. For example, in Project la, a report will be
( created based on the Sales table. A record will be added to the Sales table (the

record source for the report) and the added record will display in the Sales report.

(. Preject ‘ia ‘Greating a Report with the Report Button Part 1 of 5
( ' Open 6-Dea1h01n accdb ﬁom the ALlC() folden on your stmage medium and enable the '.j S
“content. -
2 Create a zepmt based on the Sales table by completmg the fo}lomng steps
( + " a. Click Sales in the Tables gloup in the Na\rlgatlon pane L .
b Click the Create tab. : :
{ S Chck the Rep(nt button in the Repmts gioup

( Foim Wizard ‘:l D
alt
R B 5 B S FE3 Navigation ~

. © o o {Application Table TYable SharePoint Guery Query Form Form Blank Report Blank
[ ‘ i Parts * Design  Lists+  Wizard Design Design Form EEirore Forms - i ‘ﬁzat}esign Report

R S Tewplales  Tables Gueties Forms Repo]
, o LAl Access ... © «

SO Tables & 2
(' T3 becefas

(B .
( 7] quetss ’,. 23.’
( _. ool Queries
( "d. Save the report by clicking the Save button on the Quick Access Toolbar and then clicking
" OK at the Save As dialog box. (This saves the report with the default name Sales.)

{ ¢ Close the Sales report. -
‘ 3. Add a record to the Sales table by completing the following steps:
" a. Double-click Sales in the Tables group in the Navigation pane. (Make sure you open the

{ " Sales table and not the Sales report.)
b, Click the New button in the Records group on the Home tab.
( ¢. Press the Tab key to accept the default number in the SalesID field.
- d. Type 127 in the ClientID field and then press the Tab key.
( e Type 2018 in the CalendarYear field and then press the Tab key.

- f. Type 176420 in the Sales field.
~g. Close the Sales table.

{ 4. Open the Sales report and then scroll down to the bottom. Notice that the new record you
added to the Sales table displays in the report,

! 5. Close the Sales report.

(

{
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6 Use the SalesZOl?Quely quely to Cleate a 1epo:t by compietmg the followmg steps S

Lia Click Sales201 7Query in the Queues gloup in the Nawgatlou pane

e "_b Click the Create tab, =~

e, Click the Repmt button in the Repmts gxoup EROE RN - S
iRt __.'_"Access automatlcally inserted a total amount for the Snles column of the 1ep01t Delete A
-+ this amount by scrolling down to the bottom of the report, clicking the total amount at |

o ‘the bottom of the Sales column, and then pressing the Delete key (Thls deletes the tOt‘ll

ek ﬁ;ﬂamount but not the undelhne above the amount.) .

Managing Control
Objects ina
Report

Savethe repmt by chckmg the Save button on the Qulck Access Tooibax typmg 2{ l 75 1§Ls
: _'5m the Ru,pmt Nnme text box in the Save As dlalog bO\ and then chckmg OK _ S

Modifying a Report

Make modifications to a report as nceded to address specific needs. For example,
select, size, move, edit, or delete control objects in a report; sort records in
ascending or descending order, and find data in a report. Use options in Print

Preview to customize a report and, if the report is no longer needed, delete the
report.

Managing Control Objects

A report, like a form, is comprised of control objects, such as logos, titles, labels,
and text boxes. Select a control object in a report by clicking the object and the
object displays with an orange border. Click in a cell in the report and Access
selects all of the objects in the column except the column heading. Select adjacent
control objects by pressing and holding down the Shift key and then clicking
objects or select nonadjacent control objects by pressing and holding down the
Ctrl key and then clicking objects.

Like a form, a report contains a Header section and a Detail section, Select
all of the control objects in the report in both the Header and Detail sections by
pressing Ctil + A. Control objects in the Detail section are contained in a report
table, To select the control objects in the report table, click in any cell in the
report and then click the table move handle. The table move handle is a small
square with a four-headed arrow inside that displays in the upper left corner of
the table (see Figure 6.1). Move the table and all of the control objects within the
table by dragging the table move handle using the mouse.

Change the size of control objects by dragging the border of a selected
control object or with the Width and Height property boxes in the Property Sheet
task pane with the Data tab selected. To change the size of a control object by
dragging, sclect the object (displays with an orange border) and then, using the
mouse, drag a left or right border to increase or decrease the width or drag a top
or bottom border to increase or decrease the height of the control object. When
dragging the border of a control object, a line and character count displays at the
left side of the Status bar. Use the line and character count numbers to adjust the
width and/or height of the object by a precise line and character count numben.

The width and height of a control object or column of control objects can
be adjusted with the Width and Height property boxes in the Property Sheet task
pane. Display this task pane by clicking the Property Sheet button in the Tools
group. In the Property Sheet task pane, click the Data tab, select the current
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A Ascending

4| Descending

Sort Records

1. Click in figld
¢ontaining cata.

2. Click Ascending
button or
Descending bution.

S| Find

Customizing a
Report in Print
Preview

@\ Print Previevs

measurement in the Width or Height property box, type the new measurement, and
then press the Enter key.

A selected control object can be moved by positioning the mouse pointer in
the object until the pointer displays with a four-headed arrow attached. Click and
hold down the left mouse button, drag to the new location, and then release the
mouse button. To move a column of selected control objects, position the mouse
pointer in the column heading until the pointer displays with a fowr-headed arrow
attached and then click and drag to the new location. While dragging a control
object(s}, a pink insert indicator bar displays indicating where the control object(s)
will be positioned when the mouse button is released.

Some control objects in a report, such as a column heading or title, are label
control objects. Edit a label control by double-clicking in the label control object
and then making the specific changes. For example, to rename a label control,
double-click in the label control and then type the new name.

Sorting Records

Sort data in a report by clicking in the field containing the data to be sorted and
then clicking the Ascending button or the Descending button in the Sort & Filter
group on the Home tab. Click the Ascending button to sort text in alphabetic
order from A to Z, numbers from lowest to highest, and dates from earliest to
latest. Click the Descending button to sort text in alphabetic order from Z to A,
numbers from highest to lowest, and dates from latest to earliest.

Finding Data in a Heport
Find specific data in a report with options at the Find dialog box. Display this dialog

box by clicking the Find button in the Find group on the Home tab. At the Find
dialog box, enter the search data in the Find What text box.

The Match option at the Find dialog box is set at Whole Field by default. At this
setting, the data entered must match the entire entry in a field. To search for partial
data in a field, change the Mateh option to Any Part of Field or Start of Field. If the
text entered in the Find What text box needs to match the case in a field entry, click
the Maich Case check box to insert a check mark.

Access searches the entire report by default. This can be changed to Up to tell
Access to search from the currently active field to the beginning of the report or
Down to search from the currently active field to the end of the report. Click the
Find Next button to find data that matches the data in the Find What text box.

Displaving and Customizing a Report in Print Preview
When a report is created, the report displays in the work area in Layout view. In
addition to Layout view, three other views are available: Report, Print Preview, and
Design. Use Print Preview to display the report as it will appear when printed.

'To change to Print Preview, click the Print Preview button in the view area at the
right side of the Status bar. Another method for displaying the report in Print
Preview is to click the View button arrow in the Views group on the Home tab or
Report Layout Tools Design tab and then click Print Preview at the drop-down list.

In Print Preview, send the report to the printer by clicking the Print button
on the Print Preview tab. Use options in the Page Size group to change the page
size and margins. To print only the report data and not the column headings,

Access Level 1 | Unit2 Chapter 6 | Creating Reports and Mailing Labels
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report title, shading, and gridlines, insert a check mark in the Print Data Only
check box. Use options in the Page Layout group to specify the page orientation,
specify the number and size of columns, and display the Page Setup dialog box.
Click the Page Setup button and the Page Setup dialog box displays with options
for customizing margins, orientation, size, and columns. The Zoom group contains
options and buttons for specifying a zoom percentage and for displaying one, two,
or multiples pages of the report.

Deleting a Report

iz If a report is no longer needed in a database, delete the report. Delete a report by
Delete a Report clicking the report name in the Navigation pane, clicking the Delete button in the
1. Click report name in-~ Records group on the Home tab, and then clicking the Yes button at the

2%;?3?%2?&5 %ﬂ%m confirmation message. Another method is to right-click the report in the

on Homne tab, Navigation pane, click Delete at the shortcut menu, and then click the Yes at the
g'HG“CkYES- message. [ a report is being deleted from the computer’s hard drive, the

1. Right-click report confirmation message will not display. This is because Access automatically sends
name in Navigation  the deleted report to the Recycle Bin, where it can be retrieved at a later time, if
pans. |

2. Click Dalato. necessary.

3. Glick Yes.

Project 1B Adjusting Contro! Objects, Renaming Labels, Finding and Sorting
Data, Displaying a Report in Print Preview, and Deleting a Report Part20f 5

1. With the 2017Sales report open, reverse the 01de1 of the Rprame and Client columns by
- . completing the following steps:
‘a. Make sure the report displays in Layout view.
b. Click the RepName column heading. o '
‘. Press and hold down the Shift key, click in the fhst control ob}ect below the RepName
. column heading (the control object containing

. " Linda Foster), and then release the Shift key. _ _' . llcé;
_d. Position the mouse pointer inside the RepName - ‘ Y
column heading until the pointer displays “ B\ }

with a four-headed arrow attached.

~e. Click and hold down the left mouse button,
drag to the left until the vertical pink insett
indicator bar displays to the left of the Client
column, and then release the mouse button.

2. Sort the data in the Sales column in
descending order by completing the
following steps:

a. Click the Home tab.

b. Click in any field in the Sales column,

'c Click the Descending button in the
‘Sort & Filter group.

3. Rename the RepName label control as
Representative by double-clicking in the
label control object containing the text
RepName, selecting RepNume, and then : : : e s
typing Representative, e e e AN TRt cme

ill.’uilfu-slfr ) B
Cjlanedsia
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5

Double Cllck in the Sﬂk’s Iabel contmi and then 1ename 1t ths 201 7
Move the IBPOIt table by completmg the foHowmg steps

- a, Click in a cell in the xeport. -

' b. Position the mouse pointer on the table move handle (a smaH squale mth a fom headcd B
= ‘arrow inside that displays in the upper left corner of the table) e '
" ¢."Click and hold down the left mouse button, drag the report. table to the 11ght untﬂ 1t

: -_1s ‘centered between the left and nght sides of the Detail section, and then 1elease the RN
mouse button. (When you dmg mth the mouse you wxli see only outlmes of some of o
i the Contlol ob]ects.). SR i o : S

‘triday, Ocioher 19,2018

Represemallve} 4 Client | Sales 2017

. Display the report in Print Preview by clicking the Print
- Preview button in the view arca at the ught side of the
- Status bar. - '

. Click the One Page button (aheady

. Click the Zoom button arrow in the

. Click the One P’lge button in the -
. Zoom group,

10.
SEa ;button on the Print Preview tab and |

1 Andre Kulisek HE Systems 4$554,120.00 ©

active) in the Zoom group to dlspldy
the entire page.

v hEsiging : E@d
. fnt Data Onty tandscape Columns Page

faga izmout

;‘ 3 rit lc‘lw.
{ ~

105 .,

Zoom group and then click 50% at the RN
drop-down list. '

Print the report by chckmg the Punt

“then chckmg OK at the let dlalog
hox.

11

. Close Print Pxewew by chckmg the Close Punt Plewew button at the ught 51de of the P11nt

s Preview tab.

1.
13.¢

Save and then close the 2017Sales 1ep01t . e : .
Create a report with the Representatives table by compietmg the followmg steps _

. .a. Click Representatives in the T‘lbles gloup in the Na\rigatmn pane. .-
- "b, Click the Create tab. :

e Click the Report button in the Reports group.
“14.

Adjust the width of the second column by completmg the foHowmg steps

S a. Click in the RepName column heading, :
B b D1ag the right border of the selected column headmg to the left untli Lams 1 C'lmmcte:a 1o

15.C
- f'.-"(]_é_!epi_mn_a)_ to Lines: 1 Characters: 12 and the fourth column (Email) to Lines: 1 Characters: 13.

‘displays at the left side of the Status bay, and then release the mouse button _—
Completc steps similar to those in Step 14 to decrease the width of the third column
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16 Ad]ust the mdth of thc QuomID column and the w1dth and helght of the txtte conuol SR
S ._'-_'ob;ect by completmg the followmg steps: ' : SRR e
. 7a, Click in the QuotalD column heading. ST SN
. b. Click the Property Sheet button in the Tools gloup 'md 1f necessaiy chck the meat tab.
e Select the current measmemem in the lszdth p10pelty b0>. t)rpe (} E> and then plESS the
Entm key. fETRS ST
o, Click Rtp:esenmtms in the tnt!e contlol ob]ect IR
e Select the. current measmement in thc I’Vm‘th plOpElty box type 2 and then pxess the
" Fnter key. S e
- £ With the current measurement selected in the Hught plopmty l)0\ t}rpe (} 6 SR
g ‘Close the Property Sheet task pane by chckmg the Close button in thc uppel ught
oo corner .of the tdsk pane, .. :
17, Search for fields containing a quotd of 2 by Complctmg the followmg steps
. -a. Click in the RepID column heading,
*’b. Click the Home tab and then click the Fmd button in the Fmd group.
- c. At the Find dialog box, type =~ ° :
-2 in the Find What text box.

o d Make sure the Match option A7c A7e;
s set to Whele Field. P AN
- (if not, click the Mateh Find . ? bt
" .option box arrow and Find yd
7 then click Whele Field at : .

Find What: [2[/ ’

.. the drop-down list.)
.- e. Click the Find Ne\t
CCibutton, -
f. Continue Chckmg the !
" Find Next button until a serc (M0 [V
. . message displays Stating [ ]tatch Case .-} Search Fields As Formatied
.- that Access has finished
- searching the recoxds. Click
.. OK at the message.

o (e ] 17d)

Match: \hole Freld -

~'g. Click the Cancel button to close the Find dialog box. /ISC
18. Suppose you want to find information on a representative [
.- and you remember the first name but not the last name, /
- Search for a field containing the first name Lydia by Find /
“completing the following steps: ) -
a, Click in the RepID column heading. Fndhets 130
-+ b. Click the Find button in the Find group. 3 ,,,, __
- c. At the Find dialog box, type Lydia in the Find What text Lock In: |current d"ff”“‘{"t i
o boxs  Match: Whole Fleld |1
'd Click the Match option box arrow and then click Any  Search: ﬁ%&%ﬁmm beld (]
Part of Field at the drop-down list. ' N StatofFiely | larc
e  Click the Find Next button, (Access will find and qelect e J
“ . the representative name Lydia Alvarado.) R : \ ,-'!
£, Click the Cancel button to close the Find dialog box. ' ' 18d’

19 Click the control object at the bottom of the RepID column
~.containing the number 17 and then press the Delete key.
(This does not delete the underline above the amount.)
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20 watch to Punt Plevmw by chckmg the \flew button arrow in the Vlews gloup on the X i
e _'-Home tab and then clicking Print Preview at the dmp -dovwn list. o o
'21_.;C11ck the Malgms button in the Page Slze gxoup and then chck Nm mzd at the

'_._-'-.'--'dlop down IlSt : .

=
'ilr‘s
B

;: | Descend A,d-'anced 3 =
' ; s iy Ij * Refresh P Size
meat Pa1nler_ Lo 22 Remrove Sort T Tegy'e f Ter o any : RREAS

e e Scrt & Fiter : RS LT

«] u R!plﬂtﬂlllrfei\ . i A" Acceﬂ [j_:] LelL-:

Sottenr 05"
Right 1"

Telephone

zaam + Wide
E E {317)555-8374 Top: 17 Bottom:1°
! Lefi 075 Right: Q.75

1 Narrow
| Tep 025 Bottom:0.25°
1ol let 025 Right 025

22, _Demease column w1dth (so gray shading does 0 sees
“not print on a sccond p'lge) by completmg the Queties
_-followmg steps: - L o

a. Click the Columns button in the Page Layout gxoup on the Print Pxewew tab.
b, Select the cunent ‘measurement in the Width measmement bO\ in the C'ulumn Size

B section of the dialog box and then type 8. 5 :

e Chck OI( to close the dnlog b0\

Page Setup ? X

Prirt Options page . Colmns

Grid Seltings

Lisnber of Columins: [1 l
Rerve Spading: !ﬁ“ |
ORI TPl 30725‘ :

22h; |
__\CD‘mﬂnS"ZE L
Dsamasmt“

Co’ucm bayout

.o Drwn, then Across

3 Across, ten Downn

122¢)

23 Punt the 1ep01t by clicking the Print button at the left 51de of the Print Preview tab and
~then clicking OIC at the Print dialog box.
24 Close Print Preview by clicking the Close Print Preview button
25, Save the repost with the name Representatives. o :
26. Close the Representatives report.
27. Delete the Sales report by right-clicking Sales in the Reports group in the Navigation pane,
“clicking Delete at the shortcut menu, and then cicking Yes at the confirmation message.
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Formatting a Report

Formatting a Customize a report in much the same manner as customizing a form. When a

Report report is created, the report displays in Layout view and the Report Layout Tools
Design tab is active, Customize control objects in the Detail section and the Header
section with buttons on the Report Layout Tools ribbon with the Design tab,
Arrange tab, Format tab, or Page Setup tab selected.

The Report Layout Tools Design tab contains many of the same options as
the Form Layout Tools Design tab. Use options on this tab to apply a theme,
Totals insert controls, insert header or footer data, and add existing fields. Use the Totals
button in the Grouping & Totals group to perform calculations, such as finding
oy the sum, average, maximum, or minimum of the numbers in a column. To use the
W Hint Thethemes  Totals button, click in the column heading of the column containing the data to be
g:giiﬁzlgln’;ﬁe totaled, click the Totals button, and then click a function at the drop-down list.

thermes available in NE - " : . . "
word, Exce, ang Click the Report Layout Tools Arrange tab and options display for inserting

PowerPaint. and selecting rows, splitting cells horizontally and vertically, moving data up or
down, controlling margins, and changing the padding between cells. The options
on the Report Layout Tools Arrange tab are the same as the options on the Form
Layout ‘lools Arrange tab.

Select and format data in a report with options on the Report Layout Tools
Format tab. The options on this tab are the same as the options on the Form
Layout Tools Format tab. Use options to apply formatting to a report or specific
objects in a report. To apply formatting to a specific object, click the object in
the report or click the Object button arrow in the Selection group on the Report
Layout Tools Format tab and then click the object at the drop-down list. To format
all objects in the report, click the Select All button in the Selection group. This
selects all objects in the report, including objects in the Header section. To select all
of the objects in the report table, click the table move handle.

Use buttons in the Font, Number, Background, and Control Formatting
groups to apply formatting to a cell or selected cells in a report. Use buttons in
the Font group to change the font, apply a different font size, apply text effects
(such as bold and uniderline), and change the alignment of data in objects.

Background  Insert a background image in the report using the Background button and apply
formatting to cells with buttons in the Control Formatting group. Depending on
what is selected in the report, some of the buttons may not be active.

Click the Report Layout Tools Page Setup tab and the buttons that display are also
available in Print Preview: For example, the tab contains buttons for changing the page
size and page layout of the report and displaying the Page Setup dialog box.

Applying Conditional Formatting to a Repornt

Applying Apply conditional formatting to a report in the same manner as applying
Conditional conditional formatting to a form (covered in Chapter 5). Click the Conditional
Formatling to a Formatting button in the Control Formatting group on the Report Layout Tools
Report

Format tab and the Conditional Formatting Rules Manager dialog box displays.
=1 Conditional Click the New Rule button and then use options in the New Formatting Rule dialog
Eﬁ% Formatling box to specify the conditional formatting,
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Pm;ect 16 Applymg Formattmg toa Report Part 3 of 5

j.'_: 1. \‘Vlth 6-Dealb01n accdb open open the 20] 7Sales lepmt
A Dlsplay the 1epmt in Layout view, o
'3 ‘Click the Themes button in the Themes gloup R
i on the) Repont Layout Tools Demgn tab and then R
ik Ton at the drop- down gallmy R o
i, _.'Click the Title button i in the Headellr 00t€l
aogroup (whlch selects the current tltle) type
2017 S:tles and then press. the Enter key.
Inseri a row of empty cells in the 1ep01t by
cmnpletmg the fo]lowmg steps g S
A, Chck n the Repnsenmtme cell. '

b Click the Report Layout Tools Anange tab S
c Chck the Inseat Above button in the Rows & R
“Columns group. - PO R

"16 Merge the cells in the new row by

S completmg the follomng steps: :
A Click in the empty cell unmedlately

- ‘above the Representative cell.

B f'b Press and hold down the Shlft key

(:hck nnmedlately above the Sales TERS ] [P M;'t [ setect Columa
© 2017 cell, and then release the Shlft i abore Betow Lent Right £ select Row

S Rons & CoTis

- key. (Thls selects three cells ) R o [

e -'c. Click the Merge button in the :. 3 :' : el :
Co i Merge/Splitgroup. ot iy 017 Sales
: d Type Duubm n 2017 Sales in the new |
el L :
e 'Spht a cell by completmg the followmg I _
istepst o o .:"""6'&1"-‘.1 -
Sla C,hck in the 2017 Sahs tltle in the o 5])
-\ Header section. - EERT ' Lo
: 'b Split the cell contalmng the Utie by chckmg the Spht Honiontally button in the o
i Merge/ Split group. '
- c “Click in the empty cell muncdlately 11ght of the celi contaunng the title Srzhs 201 7 and
* . then press the Delete key. (Deletmg the cmpty celi causes the date and time to move to
- oo ithe left in the Header section,)
8. Changc the report table margins and paddmg by completmg the foiio\vmg steps:
2 a Click in any cell in the Detail section and then click the table move handle in the upper
-left corner of the Dearbarn 2017 Sales cell. {This selects all of the control ob]ects in the
0 report table in the Detail section.) :
"b Chick the Control Margins button in the
" Position group and thcn click Narrow at the
. drop-down fist,
_'_c Click the Contlol Paddmg button in the
- Position group and then chck Medmm at the
(hop down list. : -

i Representolives Ctenl
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9 Chck in the Dembom 201’ 7 Sales cell aud then (hag down the bottom bmdei 50 all of the
“text in the cell is visible. . S o
10 Change the font for all of the data in the 1ep01t by completmg the followmg steps R

“ia Press Ctrl + A to select all contlol ob]ects in the l€p01t (An 01ange bmder dlSpla)’S

‘around selected ob]ects) - S S

b. Click the Report Layout Tools Founat tab Sl i S :

¢, Click the Font option box arrow in the Font gmup and then chck Cnmbrm at the leP

d 'wn llSt (You may 1 need to_'_s 10H down th 3 llSt to dlsplay C'nmb; ia. ) S

1 Calibei Light i
B S‘Lct.'\ RN FrCsi.llfonna.nl'TB :

Ali Access

08 Maiiln T Cambria Math
(] Tables r Candara

S Eerafis ?r CAS]'E[LAR

A 2 T Centaur

o i:i Gustas Ry Cﬁﬁhﬂ'}

11 Apply bold f01mattmg and change S
“ithe ahgnment of the column headmgs
b)r completing the following steps: .
~a, Click Dearborn 201 7 Sﬂles to select '_ :-
: o the Contlol ob]ect n L
b ‘Press and hold down the Sluft key
" click Sales 2017, and then release
_the Shift key (Tlus selects f0u1

. /7 ooz

= 0 w4

: b 244

cells) o
e Click the Bold button in the Font B
_goup. G Zl-ﬂ%';?
d Click the Centel button in the R
“Font group. : '

12 meat and apply COHdl(iOllal fonnattmg to the amounts by ompletmg the followmg steps
a. Chck the first field value below the Sales 201 7 column headmg (Thxs selects all of the L
- amounts in the column.) - = 2
b Chck the Decxease Decnnals button in the_Numbm gloup two tlmes

sv, wiE sm;—\.

. brages
Frise . =

Deartorn 2017517&5

i snznn :

pregentative Clizat

i c Click the Conclitior\él Formatting button in tl\e Control Formatting group.
'd. At the Conditional Formatting Rules Manager dialog box, click the New Rule button.

184 Access Level 1 | Unit 2 Chapter 6 | Creating Reports and Mailing Labels



t the New Founattmg Rule :
_1alog box, click the optlon bO\ o
-arrow for the second option box in .
- the Edit the rule. desmpnon section '
and then click gleatm ﬂ!(m at the e
.~ drop-down list, = L
. Click in the text. hO\ 1111111ed1ate]y

_gredter-than and then type 199999,
L arrow and then click the Green 2
olor optmn (seventh column i
“third 1ow)
7 h Click OK, SRR :
o At the Condltlonal meattmg Rules

. “Rule button,”
1§, At the New Fomnttmg Rule
. dlalog box, click the option box =
. arrow for the second option box ..
" in the Edit the rule description
' 'section and then click less than at
' .'the lep down llst _ .
ik Click i in the text bO\ mmledlately
~right of the option box containing
oo dess than and then type 20 U[}O{)
i '1_ Click the Background color -
*“button arrow and then dlick thc N
: '.'f\Imaon 2 colox option (smth
S column, thnd row). -
m Click OK to close the New
SRR --‘_meattmg Rule dialog box.
i .':n_ Click OK to close the Conditional
" Formatting Rules Manager dialog box.

U seeasateyre RN

1ght of the option box _containing -

‘g.Click the Background color button i

] New Formsttng Ru'e

Chedovaies ke nna:l eecord Of 158 &1 Elpfﬂ;\:ﬂ
Compsreia ct"d recoeds

: Ed’ubenrem;n.« R R
Fgmaloa.‘,'(emnbue'.bﬁ

‘b:!\-a_-ab L gezdlhn 7_’5 555

- Manager dlalog bo*( chck the New o

S

| [chidk valois T 152 eurv ek retoc] of G &0 z\;(éss'c& B
- Coorgare bo C4Me cecteds 1

[f Edtthe nfe Sesorption \

* Predes B T

¥ewn Foematling Ru'e

< | St anfe bype

Format ondy cells whaise I

. freiviies (o] avar %% o

by Formast S,

13 Sum the totals in the Sales 2017 column by

¥ completmg the following steps:

~a. Click in the Sales 2017 column headmg
+ . b. Click the Report Layout Tools Design tab.
“¢. Click the Totals button in the Grouping ‘
~ & Totals group and then chck Sum at the asor AR N

dlop ~down list.

14. Chck in the Sales 2017 sum amount (at the
~" bottom of the Sales 2017 column) and then

136

"""51 Count Be?aﬁ%

'dlag down the bottom border so the entire

. amount is ws:bie in the cell.

15 Change the top margin by completing the foilowmg steps
. Click in the Repr esentative column headmg and then click the Report Layout Tools Page

Setup tab.
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= :':b Click the Page Setup button m the Page Layout _

Page Setup
SRS gloup RN

e _"_fc ‘At the Page Setup dialog bO\ thh the Pnnt i ] e options page  Colarns]

o Optlons tab selected, select the current =7 I \ T
11 . Margins (inches) e :

““measurement in the 'Ibp mcasmement box and S . e

_ i T fog— :

L “then type (} 5. : . B

e d Click OK to close the Page Setup chalog b0\ P Bottom: | 9,25

::."-'-1_6.3Change the ) page size by clicking the Size button in o
- ithe Page Size group. and and then chckmg Legal at the o
- drop-down list, '__

E| 7.:Display ‘the 1ep0rt II‘l Punt Plevlew by chckmg the F;Ie tab R
T clicking the an‘ optlon aud then chckmg the Pum‘ mew ":': S
~ 7 option, S DURRER
-18. Click the One Page button in the Zoom gloup and notlce that =

" "the entire report will print on one legal -sized page. :
19, __Chck the Close Print Preview button to retwrn to the 1ep01t
20, Change the page size by clicking the Page Layout Tools Pftge _
~.:Setup tab, clicking the Size button in the Page Slze gloup, and
. 'then clicking Letter at the drop- down fist., - -- SRR RIS,
‘21. Insert and then remove a backglound image by comp]etmg the followmg steps o
“a, Click the Report Layout Tools Format tab. - i :
B b Click the Background Image button in the Backgxound gtoup and then chck Bmwse at
" the drop-down list. ceel
¢, At the Insert Picture dialog box, na\r:gate to the ALlCG foldel on yom stoaage med:um .
. ‘and then double-click Mowuntain.jpg. :
. d. Scroli through the report and notice how the i 1mage (hsplays in the 1ep01t
: "c Click the Undo button on the Quick Access Toolbar to remove the backglound lmage
~(You may need to click the Undo button more than once.) : _
22 Print the report by clicking the F:Ie tab chckmg the Pl int optlon ancl then chckmg the
- Quick Print option. TR S . _ : SRR
23 Save and then close the report.

H Executive ]
-l 7257 x 1050 i

Grouping and Sorting Records in a Report

Grouping and A report presents database information in a printed form and generally displays
Sorting Records data that answers a specific question. To make the data in a report easy to
in a Report understand, divide the data into groups. For example, data can be divided in a

report by regions, sales, dates, or any other division that helps clarify the data for
the reader. Access contains a group and sort feature for dividing data into groups

Add and sorting the data.
z a grou
: oroip Click the Group & Sort button in the Grouping & Totals group on the Report

Layout Tools Design tab and the Group, Sort, and Total pane displays at the
bottom of the work area, as shown in Figure 6.2. Click the Add a group button in

Group and Sort

Records the Group, Sort, and Total pane and Access adds a new grouping level row to the
1. Open repart in pane, along with a list of available ficlds. Click the field by which data is to be
) (L:Fl{yiuévfe\'ﬁ& Sort grouped in the report and Access adds the grouping level in the report. With
‘bulfmn.mp options in the grouping level row, Changel the group, specify the sort order, and
3.ClickAddagroup  expand the row to display additional options.
hution.

4, Glick group field.
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Figure 6.2 Group, Sort, and Total Pane
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PR [ [P (1Y)

Group, Sort, and Tedal

[iz Add a group 2] Add asont

el 8 G GHG ¥
Group records by a specific ‘L Sort records by a specific
field by clicking this bution field by clicking this button
and then clicking the field. i and then clicking the field.

When a grouping level is specified, Access automatically sorts that level in
ascending order (from A to Z or lowest to highest). Additional data can be sorted
Add a sort within the report by clicking the Add a sort button in the Group, Sort, and Total
pane. This inserts a sorting row in the pane below the grouping level row, along with
¢y i a list of available fields. At this list, click the field by which to sort. For example, in
o gg;ﬁfﬁﬂg‘frate Project 1d, one of the reports will be grouped by city (which will display in ascending
groups of records order) and then the client names will display in alphabetic order within the city.
visually.

[
€""'

To delete a grouping or sorting level in the Group, Sort, and 1otal pane, click
the Delete button at the right side of the level row. After specifying the grouping and
sorting levels, close the Group, Soit, and Total pane by clicking the Close button in
the upper right corner of the pane or by clicking the Group & Sort button in the
Grouping & Totals group.

Project 1d Grouping and Snning Records in a Report Part 4 of 5

1. With 6-Dearborn.acedb open, create a 1ep01t with the Clients table using the Report
. button on the Create tab. '
- 2. Click in each column heading mdmdually and then demease the size of each column 50
~the right border is just right of the longest entry. :
3. Change to landscape orientation by completing the followmg steps:
. -a. Click the Report Layout Tools Page Setup tab.
~"b. Click the Landscape button in the Page Layout group. '
"4, Group the report by zeplesentatwe ID and then sort by clients by completing the
.+ following steps:
‘a. Click the Report Layout Tools Design tab.
b Click the Group & Sort button in the Grouping & Totals group.

Access Level 1 | Unit 2 Chapter 6 | Creating Reports and Malling Labels
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:-::':; c, Chck the Add a gloup button m the Gloup, Smt, and Total pane :-::-:::'_I- e

~»a. Click the File tab, click the Print opuon and then _

- field group are not in alphabetm order.

-.'g.'Chck the Client field in the hst b0\ s
. names are now alphabetized wlthm RepID fxeld

. i Close th.e.Gxoup, Smt and Totai pane by chckmg _.

* 5. Save the report with .the name RepIDGmupedRpt i
-6. Change column width and print the first page of the | o !Léis';'“’“
. “report by completing the following steps: R 1

: ._ Group Sort, and Total

__.'"_Scmll tluough the 1ep01t and notlce that the
- records are g1ouped by the RepID field. ‘Also, -
notice’ that the chent names within each chID_ Sy

f. Click the Add a sort button in the Group Sbl t,_' i
“and Total pane, -

h. Scroll through the report and notice that client

.__‘L

. groups.

gy

~ the Group & Sort button in the Gloupmg &
“Totals group.

e, presswcm

~click the Print Preview option.

:jb Click the Colunwns button on the Print Ple\rlew tab select the cuuent measmement in

“the Width measurement box, type 10, and then click OK

- ¢. Click the Print button on the Print Preview tab. v :
- d, At the Print dialog box, click the Pages option in the Print Rm:ge section,

=

e. Type | in the me te\t box, press the Tab key and then typc 1 in the ’Eﬂ te\t.bO\

. Click OK. :

. Close the RepIDGroupedRpt 1ep01t : '

. Create a report with the InOlMunSaIesOvelS99999Quely quety usmg the Repoxt button
‘on the Create tab. Make sure the report displays in Layout view.

. Group the report by city and then sort by clients by completing the followmg steps:

a. Click the Group & Sort button in the Grouping & 'Totals group on the Repmt Layout
. Tools Design tab.

b. Click the Add a group button in the Gloup, Sort, and Totai pane Lo
-¢. Click the City field in the list box. :

- d. Click the Add a sort button in the Group, Smt and Total pane ;_' _ ':::__.ﬁ: .
e, Click the Client field in the list box. :

10.
11.
12,
13.
- the content.

5_f Close the Group, Sert, and Total pane by chckmg thc G:oup & Smt button in the . ': _

“Grouping & Totals group.
Print the first page of the report. (Refm to Step 6 ) S SR
Save the report, name it Im\lthnlcsOm$99999, and then close the 1cpont
Close 6-Dearborn.accdb. : L :
Open 6-WarrenLegal. acedb from the AL1IC6 folda on your stonage medlum and enable '
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14 De31gu a queny that extlacts 1ec01ds f10m tlnee tabies Wlth thc followmg spec1f1cat10ns
% “a,°Add the Billing, Clients, and Rates tables to the quer y wmdow 2 S
b Insert the LastName field ﬁom the Clients table field list b0\ in the first ﬁeld m the Fteld 10w R
- e, Insert the Date field from the Bllhng table field list box in the second field in the Field row.
coed, lnseit the Ham‘s field from the Billing table field list box in the third field in the Field mw ;
" ‘e Insert the Rate field from the Rates table field list box in the fourth field in the Fmiri row, i
R Click in the fth ﬁeld in the Freln’ xow, type '10h{}. [Hours}* [Ratc] and then p1ess the 0

IIEEntel key SR SO L O : :

Field: |LastName Bate
Table: | Clients Eltng
Sort:
shows|
criterias |~
o

“:g. Run the query. .
. Save the query with the name ClientBilling.
i. Close the query.
15. Create a report with the ClientBilling query using the Report button on the Create tab.
16. Click in each column heading individually and then dec1ease the size of each column s0
- the right border is near the longest entry. ' e : o
17. Apply cuuency fm mattmg to the numbels in the l‘bml coiumn by compietmg the followmg
Costeps: : :
a, Chck the Repou Layout Toois F(nmat Vs ey T g
o tab. SRR 1 /3 BTN Ve I Y
b Cllck in thc fust flcld below the I?Jtal Lo '
" ‘column (the field Contammg the '

: I HUInbel 350) . _' L (Delcﬂ) N Y ey
R Click the Apply (,uuency Fomnt iy Ase ===
“button in the Number group. ket

~d. If necessary, increase the size of the Total {4 A

. column so the entire amounts (including ~ {~
-+ the dollar symbols ($)) are visible.
18. Group the report by last name and then
~..sort by date by completing the following

Rate

Date

Hours iTotat

shpoell 175

'."_'stepg | eninsl]  osell 320000 _
-.a. Click the Repmt Layout Tools Demgn i s 200 sw00 f sa0000 |
©tab.

- 'b. Click the Group & Sort button in the Gtoupmg & Tota]s gloup

-+ c. Click the Add a group button in the Group, Sort, and Total pane.

.- ~d. Click the LastName field in the Tist box.

- “e. Click the Add a sort button in the Group, SOIE and Total pane..

- F Click the Date field in the list box.

* g, Close the Group, Sort, and Total panc by chckmg the Close button in the upper ught

- corner of the pane.

19. Scroll to the bottom of the report and delete the total amount in the Rate column and the
line above the total. (Click the line and then press the Delete key.)

20. Save the report with the name ClientBillingRpt.

21. Close the report.
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Inserting a Caleulation in a Beport

Inserfing & Like a form, a calculation can be inserted in a report in a text box control
Caleulation in a object. To insert a text box control object as well as a label control object, click
Report the Text Box button in the gallery in the Controls group on the Report Layout

Tools Design tab, and then click in a location in the report where the two

objects are to display. Click in the label control box and then type a label for the

Insert Calculation in calculated field.
Report

1, Click Text Box button Insert a calculation by clicking in the text box control object and then
onReport Lyt clicking the Property Sheet button in the Tools group on the Report Layout

g E?i%ls i'{iersgggﬂtatg. Tools Design tab. At the Property Sheet task pane, click the Data tab, click in
insert label and et the Centrol Seurce property box, and then type the calculation. Type a calculation

5 g‘é’éﬁ;‘gﬁg‘:ﬁ in the Control Source property box using mathematical operators and type field
" control object. names in the calculation inside square brackets. Begin the calculation with an

4. Ciick Property Sheet  equials sign (=). A field name must be typed in the calculation as it appears in

bution in Tools the source object.

group.

5. Glick Data tab. If a calculation result is currency, apply currency formatting to the text box
6. gggﬁgg gggg% by COntrol object. Apply currency formatting by clicking the Report Layout Tools

7. Type caloulation. Format tab and then clicking the Apply Currency Format button in the Number

8. Click Close button. group.

Pl‘OjeCt 18 Insertmg a ca!culatmn ina Report Part 5 of 5

1 Wlth 6- WarlenLegal accdb open open the ChentB]llngpt 1ep01t in Layout view. o
©2. Insert label and text box control objects by completing the following steps: =~ .7
‘a. Click the Text Box button in the gallely in the Contmls gmup on the Rep01t Layout
Tools Design tab.
b Position the crosshairs to the ught of the i‘bml fleld name and then chck the left mouse
~button. (This inserts a label control object and text box object in the report.) . =

: . [GreUp {5 Hide Details
& Sort

. Grouping & Tolals . . Cordrots

gk cnentaimngs&g\

SRS :
Haurs Total 7
B _ ey

Aragato o j

3. Name thc new field by chckmg in thc label contiol ob]ect doublc-chckmg the te)\t in the
Iabel contlol ob;ect and then typing Total + 99 Tax. : -
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4 Chck in the text IJO\ Control ob]ect and then msert a calcuiatrou by completmg the SR
o ~following steps: S
o _-_-a Chck the Property Sheet button in the Tools g;oup on the Report Layout Tools Desrgn o
T tab, SRR '
B f_-[b At the Pmper ty Sheet task pane chck the Data tab
e Click dn the Control Sotiree property | bos, -
o, .Tf,'pe ~[Total} 1.09 and then p1ess the Enter key

D AddExrsttng ﬂ
Gl Felds s
) Tmls .
| Property Sheet X\ el
Selection type: Test Box ] /-4.(1‘;;:
; _‘JTexm v -

}‘on'nat “Data gyent  Other

antrolsq_!gl_'ge_ i ,‘{= =

e es T

L 'e Close the Ploperty Sheet task pane by chckmg the Close button in the upper right
- corner of the task pane.
'3, _‘Wlth the text box control object still selected, apply cuuency formatting by clicking the
Report Layout ‘Jools Format tab and then clicking the Appiy Currency Format button in
-~ the Number group.
6 Save and then print the report. (The report will print on tlnee pages.).
7. Close the ClientBillingRpt report and then close 6-WarrenLegal.accdb.

Pre}eet 2 Use Wrzards to create Reports and _Labels

3 Parts:_f"f’

_You waEI create report' usmg the Report 'leard and prepare .malhng labels usmg
the Labei Wrzard S L i
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Creating a Report
Using the Report
Wizard

Report Wizard

Create a Report Using

the Report Wizard

1. Click Creats tab.

2. Click Report Wizard
hutton.

3. Chaose options at
gach Report Wizard
dialog box.

% Hint Use the
Report Wizard to select
specific fislds and
specify how data is
grouped and soried.

-Creating a Report Usihg'

the Report Wizard

Access offers a Report Wizard that provides the steps for creating a report. To
create a report using the wizard, click the Create tab and then click the Report
Wizard button in the Reports group. At the first Report Wizard dialog box,

shown in Figure 6.3, choose a table or query with options from the Tables/Queries
option box. Specify the fields to be included in the report by inserting them in the
Selected Fields list box and then clicking the Next button.

At the second Report Wizard dialog box, shown in Figure 6.4, specify the
grouping level of data in the report. To group data by a specific field, click the
field in the list box at the left side of the dialog box and then click the One Field
button. Use the button containing the left-pointing arrow to remove an option as
a grouping level. Use the up and down arrows to change the priority of the field.

Figure 6.3 First Report Wizard Dialog Box

Choose a field

‘ to be included

Lin the report

{ by clicking
the field in
i

ist box. _|

Report Vizard

Which fie'ds do you want on yr report?

You can doase from more then ona teble or query.

o p L,

IVi N

SpR— —

T Sedected Relds:

]
e
1

GClick the One
Figld button to
add a field to

" the Selected
 Fields list box. |

(lick the All
Fields button to
insert all fields

= in the Available

Figlds list box
into the Sefecled
Figlds list box.

Figure 6.4 Second Report Wizard Dialog Box

Use these
buttons to
increase or

field priority
lavel.

Report Wizard

Do you veant ta acd 2y groupng
levels?

decrease the |-
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Specify a sort order with options at the third Report Wizard dialog box,
shown in Figure 6.5. To specify a sort order, click the option box arrow for the
option box preceded by the number I and then click the field name. The default
sort order is ascending. This can be changed to descending by clicking the button
at the right side of the option box. After identifying the sort order, click the Next
button.

Use options at the fourth Report Wizard dialog box, shown in Figure 6.6, to
specify the layout and orientation of the report. The Layout section has the default
setting of Stepped, which can be changed to Block or Outline. By default, the report
will print in portrait orientation. Change to landscape orientation by clicking the
Landscape option in the Orientation section of the dialog box. Access will adjust field
widths in the report so all of the fields fit on one page. ‘To specify that field widths
should not be adjusted, remove the check mark from the Adjust the field width so all
Sields fit on a page option.

At the fifth and final Report Wizard dialog box, type a name for the report
and then click the Finish button.

Figure 6.5 Third Report Wizard Dialog Box

Report Wizard
\mmwemmuwﬁmmrmw SR I S | Glick this button
- to change the
sort order to
descending

You @n soet reuxd:s l:rr upto four fiekds, " elhér )
astendng D(descﬂnifng ordir.

| Specify a sort
order by ¢licking
this option box
arrow and then

glicking the field
name.
Figure 6.6 Fourth Repori Wizard Dialog Box
Report Wizard | Choose a layout
Hoe vioud you Exe to Lay ook your report? R : : fo'r the rgport in
Lo ] i
©-: Choose an E
© :Z .  ofientation for | ‘
Of' the repert in
|

fhis section.

{T] Adtust the Beld wikh so 21 fields fiona

o ([ seea ] wee ]| e
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;-”PE’Q}QC'E 2& Creating a Report Using the Repurt Wizard Part 1 of 3

1 Open 6 Skylme accdb ﬁom the AL1C6 fOldEl on E
- your storage. medium and enable the content L
g -.: 2. Create a report using the Report - '
S \‘\’lfard by completlng the followmg
steps:
LA, Chck the Cleate tab R RN
b, Click the Repmt W’Uald button m
. the Repmts group. ™ ' '
c. At the first Report \szald chalog
'::_ bO}; chck the 'l?rbles/Quw fes o
option box arfow and then click °
_ “Iable: Inventory at the drop-down fist. -
e "d Click the All Fields button to insert
- all of the Inventory table fields in
the Selected Fields list box.
. e. Click the Next button. ' '
£ At the second Report Wizard dialog ' T
b0\ make sure SupplierlD displays in blue at the top of the ple\qew page at the right
- . side of the dialog box and then click the Next button. .~
S g At the third Report V\’lzald dlaiog bO\ chck the Ne).t button (You want to use the
o sorting defaults.)
" h. At the fourth Report ‘N:zald dmlog box, chck the B!ork optxon in the Lry!om‘ section and
: then cllck the Next button. :

" Report Wizacd

W ﬁe';;'sdqycuva—tmycurep’xﬂ ey

Ymca r.hocsefrmvm:eﬁw\metaheofq.&q . .

N oL A 1 IR

@-a‘{a:?:eﬁgés; SERRER

L Repoit Vizard

L Hiore vio 04 yo bea ko Ry ok your repart?t

[ Adust i i ycth =0 2 Felds fton g
P23

/

R At the fi fth Repmt W'mud dlalog bO\ make sure Inm:to;y dlspiays in the What title do

L you want for your Jepwt? text bo‘c and then c:hck the Flmsh button (T he 1epmt displays in
Print Preview.) :

3. With the report in Print Ple\flew chck the Print button at the left side of the Print Preview
~tab and then click OK at the P1mt dlalog b0\ (Thc 1cp01t wﬂl print on two pages. )

-4, Close Print Preview. - "~

5. Switch to Report view by chckmg the Vuaw button on the Repmt Design Tools Design tab.
6. Close the Inventory report. o o
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( If a report is created with fields from only one table, options are specified in
five Report Wizard dialog boxes. If a report is created with fields from more than
( one table, options are specified in six Report Wizard dialog boxes. After choosing

the tables and fields at the first dialog box, the second dialog box that displays
_ asks how the data will be viewed. For example, if fields are selected from a
( Supptiers table and an Oxders table, the second Report Wizard dialog box will ask
if the data is to be viewed “by Suppliers” or “by Orders.”

(
(- iject 2b creatmg a Report with Fields from Two Tables Part 2 of 3
. 1 VVlth 6 Skylme accdb open create a 1ep01t w1th the Repmt Ry
{ - Wizard by compietmg the followmg steps -;'
' “a. Click the Create tab, R Report izara
('\ B __b Click the Repoxt leald button in the Repoz ts gloup : VN Pkt oy st
"1 ¢ At the first Report Wizard dialog box, click the '.l?rbles/ sor o b e o
( i Quenes option box arrow and then chck Table: Events at o
: - the drop-down list. = - SOl Iﬂwu%s N
. L d Click the Frent field in the Avmlable leds B T L =l
( 07 list box and then click the One Field button. - - S| e Seeded s
e, Click the Tables/Queries option box arrow and then chck e Gy
( " Table: Banquets at the drop-down list. - R -:' REN {122
R IIISClt the foliowmg ﬁelds in the Selecfed R IN g o
} FnstName : K _. . ; _: .} Report Wizard /
( : Lasd\_’a_me '
PR AmountTotal
{ Lo AmountPaid : : -
g, After inserting the ﬁelds chck the @fz/ N
E - “Next button, . L ‘
‘ *h. At the second Report leaid dlalog | it R
o box, make sure by Events is selected
L - 7"“and then click the Next button, -
FE B At th_e third Re,p(_nt W;zmd dialog
{ " box, click the Next button. (The -
: .f.-.-depoat preview shows that the
( " report will be grouped by event. ).
‘}. At the fourth Report Wizard - '
, - dialog box, click the Next button. (You want to 1 use the sor tmg defaults )
( - k At the fifth Report Wizard dialog box, click the Block option in the Layout section, click
" Landscape in the O rentatwn Sectlon and then chck the : : N
( . “Next button. :=j"1'1"‘-:
. :1. At the sixth Report Wazald dlalog bo‘< Select P
(" O '_f_he current name in the What title do_you PR
R eport Wizard
e 0 want for peur report? text box and then type _ st o yoroar ey et
~ s BanguetBEvents, ' S /_ N
! - m. Click the Finish button. o
2. Close Print Preview and then change to Layout view.
{ ‘3. Print and then close the BanquetEvents report.
‘4. Close 6-Skyline.accdb.
(
(
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Creating Mailing
Labels labels with fields in a table. To create mailing labels, click a table, click the Create

Labels

Creating Mailing Labels

Access includes a mailing label wizard that provides the steps for creating mailing

tab, and then click the Labels button in the Reports group. At the first Label
Wizard dialog box, shown in Figure 6.7, specify the label size, unit of measure,

and label type and then click the Next button. At the second Label Wizard dialog

vl s g
e 5 SEERE

Using the Label
Wizard

1. Click table,

2. Click Creals tab.

box, shown in Figure 6.8, specify the font name, size, weight, and color and then
Create Malling Labels  click the Next button.

Figure 6.7 First Label Wizard Dialog Box

3. Glick Labels button,

4, Choose options at
each Labat Wizard
dialog box.

Label Wizard

UtofMease UL labelType

rhsmzxdaaz&s;a;da;d hbe%swm!ml hbeas. R Sr i
\'uwlabeiszev-uﬁi)wlle? L T
Pfqdiﬂpumba(: : '_:j - Dimensions: L

-._._lnmr Baoss: i

Scrolt through
| 1-— this list box and
vl | 1 choose a label.

L2 N2 12
En[z x39,'itr
i 1/4" x 7 314507
2242 %2

2243 142" x4 t,'z

=W

‘@i Qb @sr»eaf«d ocmms'*-

fAecby manfecurens - rtmery R

L,f J el 5_._ S’Uifgs_lf-tnb:,{. sires S

Figure 6.8 Second Labe! Wizard Dialog Box

Labe! Wizard

|

label preview

wm fook 284 color veou1d you e oo tattoter o

; Tmappeeranoe e S “"‘““‘

: Fort name: B PR For-ts‘ze_: -

T i~} @fv} L Choose the

i Fort welgth: : U Teesen 0 [abel font name,

e T R mu size, weight,

: O Gumem-e . S and color in
EE o] | this section.

e [ese TEeT
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Specify the fields to be included in the mailing labels at the third Label
Wizard dialog box, shown in Figure 6.9. To do this, click the field in the Available
fields list box and then click the One Field button. This moves the field to the
Prototype label box. Insext the fields in the Profotype label box as the text should
display on the label. After inserting the fields in the Prototppe label box, click the
Next button.

At the fourth Label Wizard dialog box, shown in Figure 6.10, specify a field
from the database by which the labels will be sorted. To sort labels (for example,
by last name, postal code, etc.), insert that field in the Sort by list box and then
click the Next button,

At the last Label Wizard dialog box, type a name for the label report and then
click the Finish button. After a few moments, the labels display on the screen in
Print Preview. Print the labels and/or close Print Preview.

Figure 6.9 Third Label Wizard Dialog Box

Label Vizard

\'Mvm!d)wikemwm%’rghban IR

3 Cms?:udjwbbe{mma rightbfdmsfgﬁe—!dsfromﬂmla‘tYwm;a!solwe
5 tenmstyouvmﬁikztoseemewbbeh@k«t«mﬁprm )

Inser’t flelds ln
the Profofype i
| labef box.

Click the One Field button T AT
to move the selected figld |- 0ot
to the Profofype label box. |

Figure 6.10 Fourth Label Wizard Dialog Box

Label Wizard
You can sort your Labels by one or more fiekds In your detabose, You Mgk wantte
smtb-,'rmtethanomﬁe’d(sxhaslaslme ﬂ-nenﬁ-stna:rvz} orb”uaemﬁe!d
(s.vd:aspostalcode) - - L
vmnadswo.edmmtosmm e
Avarauseﬁeajs. ST Sty

To sort labels by

a particular field, |
insert that field in i
the Sort by list box. |
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f: l Open 6 WarrenLegal accdb and enable the content

.+ 2..Click Clients in the Tables _group in the Na\rlgatlon pane RRSD TR e
;'3 Chck the Cleate tab and then ehck the Labels button in the Repmts group
4 ‘At the first Label leald :
"~ dialog box, make sure Enghsh o
: _s'selected in the Umt qf RN
. Measure section, Ave:_y is
_selected in the Filterby

Wb\hud«u!esstwudiebe!s«wmube& ::
'\matlabalsuewm!dw.:&e? B e

Product pimbers 1 07 Dmengons:

:'_ﬁmmugfactmei list box, Sheet i1 1/2"x 3 9/10° 2
i feed 35 selected in the Label' !;‘,{g*”*m 2
7 Type section, and C2160 - IR ! thd

s selected in the Product

~..mumber list box and then
A click the Ne\t button R
5. At the second Label leeud
B dialog box if necessaly, :
ehange the font size to :{.
0710 points ; and then Chck
.7 the Next button, . 7" : = e
C6. At the thud Label W17a1d dlalog bo:x coxnplete

o tithe follomng steps to lnsert the ﬁelds in the
i Prototype label box; ' L = o :

- a, Click FirstName in the Avmlable ﬁelds hst box and then chck the One Field button

F b Press the spacebar make sure LnstName is selected in the Avmlable ﬁelds hst b0\ and

% then click the One Field button RO U SEAE

o c Press the Enter key (Th1s moves the 1nse1t10n pomt down to the next lme in the o
- Prototype label box.) - ' o

: d With StreetAddress seleeted m the Avm]able ﬁelds 11st box chek the One Fleld button

- “e. Press the Enter key. - .

C0f With Cigf selected in the Avmlable ﬁelds hst box chek the One Fleld button

< g Type a comma (,) and then press the spacebar. =" '

L Uh. 'With State selected i in the Avmlable ﬁelds hst box chck the One Fleld button

S, Press the spacebal R

g ": : ; Wxth erCade seleeted m the Alfmlable ﬁelds hst bO}t cllek the One Fleld button

Unt of Heasure I, .
Engh QOwatne 00 eet fecd. > -

Fter mapfacturers :_.:.' EE - R P o
. . WP ) . 124 baleize

e Label Vizard

| \:htwuédywkcam;mmﬁnglabm :

m;wbwmmmhrwdwmﬂeﬁsﬁmmmmmymw
}gj tmvntywnw!dld:eto €68 on euerylabetrig&mtotheprotolwe :

" Prototype label:

- e w e R o
{streetAddress) 08

5 _ k CliC__R_. the Next .butt(')n..
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by zip code. To do this, click ZipCode in
‘the Avmlable ﬁelds llSt. b0\ and then chck ;
o ;.'the One Field button. -
-8, Click: the Next button e '
e 9__.{At the iast Label W’lzald dlalog b0\ cllck
the | Finish_ button (The Label \\’1za1d G

automatlcally names the label 1ep01t
- Labels Clients.) .= :
10. Print the labels by dlckmg the Punt s

Duitton at the left side of the Print Plev;ew
st ab and then Clle OK at the Punt dlalog
B ""-1_1__._-Close Pnnt PAC\?IC“’ G e

12 Switch to Repmt view by chckmg the V iew :'. SR

“button o on the Rep(nt Design Tools Design tab.

I_ST'Close the labels xepmt and then ciose 6 WarlenLegai accdb

-7 _At the fomth Labei W'lzald dlalog bO\ smt_ :

i+ Label Vizard

:. Yéummmhbe.kbrom&rrmﬁédsﬁywd& -
: mrttr;rmfe&moneﬁead(wdmshszm ti'.enﬁrst

H: i \Hh.d:ﬁe’dﬂmt.ﬂd)wiﬂnetosmbﬂ
1 A\mézhhﬁeﬂs- :

(Iera_ﬂ) :
Festhame
Lastliame
StreetAdiress
Gy
Slate

Chapter Summary

# Create a report with data in a table or query to control how data appears on
the page and how the data is formatted when printed.

g Create a report with the Report button in the Reports group on the Create tab,

=

view, and Design view.

Four views are available for viewing a report: Report view, Print Preview, Layout

Use options on the Print Preview tab to specify how a report prints.

mOm

o

2

&
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In Layout view, a report control object can be selected and then sized or moved.

One method for changing column width in a report is to click a column heading
and then drag the border to the desired width.

Sort data in a record using the Ascending button or Descending button in the
Sort & Filter group on the Home tab.

Customize a report with options on the Report Layout Tools ribbon with the
Design tab, Arrange tab, Format tab, or Page Setup tab selected.

To make data in a report easier to understand, divide the data into groups using
the Group, Sort, and Total pane. Display this pane by clicking the Group & Sert
button in the Grouping & Totals group on the Report Layout Tools Design tab.

Insert a calculation in a report by inserting a text box object, displaying the
Property Sheet task pane with the Data tab selected, and then typing the
calculation in the Confrol Sewrce property box. If a calculation result is currency,
apply currency formatting with the Apply Currency Format button on the
Report Layout Tools Format tab.

Use the Report Wizard to provide the steps for creating a report. Begin the
wizard by clicking the Create tab and then clicking the Report Wizard button
in the Reports group.

Create mailing labels with data in a table using the Label Wizard. Begin the
wizard by clicking a table, clicking the Create tab, and then clicking the Labels
button in the Reports group.
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Commands Review

Find dialog box Home, Find .

er | Home, Sort & Filter ..

hapter study tools and assessment activities are avallable in the
Workbook ebook These resources are designed to help you further
develop and demonstrate mastery of the skills learned in this chapter.
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